
Mac OS X Server
iCal Server Administration
Version 10.6 Snow Leopard



Apple Inc.KK

© 2009 Apple Inc. All rights reserved.

The owner or authorized user of a valid copy of Mac OS 
X Server software may reproduce this publication for 
the purpose of learning to use such software. No part 
of this publication may be reproduced or transmitted 
for commercial purposes, such as selling copies of this 
publication or for providing paid-for support services. 

The Apple logo is a trademark of Apple Inc., registered 
in the U.S. and other countries. Use of the “keyboard” 
Apple logo (Option-Shift-K) for commercial purposes 
without the prior written consent of Apple may 
constitute trademark infringement and unfair 
competition in violation of federal and state laws. 

Every effort has been made to ensure that the 
information in this manual is accurate. Apple is not 
responsible for printing or clerical errors. 

Apple
1 Infinite Loop
Cupertino, CA 95014
408-996-1010
www.apple.com

Apple, the Apple logo, iCal, Mac, Macintosh, the Mac 
logo, Mac OS, Safari, Time Machine, Xsan, and Xserve  
are trademarks of Apple Inc., registered in the U.S. and 
other countries. 

Snow Leopard is a trademark of Apple Inc. 

UNIX® is a registered trademark of The Open Group. 

Other company and product names mentioned herein 
are trademarks of their respective companies. Mention 
of third-party products is for informational purposes 
only and constitutes neither an endorsement nor a 
recommendation. Apple assumes no responsibility with 
regard to the performance or use of these products.

019-1417/2009-08-01

http://www.apple.com


5	 Preface:�  About This Guide
5	 What’s New in iCal Server
6	 What’s in This Guide
6	 Using Onscreen Help
7	 Documentation Map
8	 Viewing PDF Guides Onscreen
8	 Printing PDF Guides
9	 Getting Documentation Updates
9	 Getting Additional Information

10	 Chapter 1:  Understanding iCal Server
10	 iCal Server Features
11	 Open Standards
11	 Directory and Client Integration
12	 Service Scalability
12	 Client Applications That Integrate with iCal Server
12	 Third-Party Applications
13	 iCal Server In Action

14	 Chapter 2:  Setting Up and Managing iCal Server
14	 iCal Server Minimum Requirements
14	 Setting Up iCal Server
17	 Planning for iCal Server Computing Resources
18	 Enabling iCal Server Administration in Server Admin
19	 Starting or Stopping iCal Server
19	 Configuring DNS for iCal Server
22	 Understanding iCal Server Administration Settings
24	 Changing the Calendar Data Store Location
24	 Changing the Maximum Attachment Size
25	 Changing Calendar User Quotas
25	 Setting the iCal Server Host Name
26	 Setting the iCal Server Port Number
26	 Setting the iCal Push Notification Server

		�  3

Contents



	 4		  Contents

27	 Enabling Mail Notifications to Attendees
29	 Creating the iCal Server’s Service Access Control List
30	 Creating iCal Resources and Locations
30	 Delegating Access to a User’s Calendar
31	 Configuring Security for iCal Server
31	 Choosing and Enabling Secure Authentication for iCal Server
32	 Configuring and Enabling Secure Network Traffic for iCal Server
33	 Make iCal Server Host a Wiki Server’s Calendar
34	 Monitoring iCal Server
34	 Viewing iCal Server Logs
34	 Setting Logging Levels
35	 Rotating iCal Server Access Logs
35	 Maintaining iCal Server
35	 Understanding iCal Server Administration Configuration Files
36	 Understanding Calendar Files
36	 Backing Up and Restoring Calendar Files
37	 Deleting Unused Calendars
38	 Supporting iCal 4.0 Client Users
38	 Account Settings for iCal Client
39	 Adding an iCal Server Account to an iCal Client
40	 Creating a Calendar on an iCal Server Using iCal Client
40	 Setting a Delegate Using iCal Client

41	 Chapter 3:  Advanced iCal Server Information
41	 About iCal Server Configuration Tools
42	 About iCal Server Scheduling Operations
42	 Understanding the Data Store and File Hierarchy for iCal Server
44	 About Process and Load Management of iCal Server
45	 iCal Server Scaling
47	 About iCal Server Implementation Details
47	 Getting the Source Code
48	 Where to Go for Additional Information
48	 Related Web Sites
48	 Standards Documents

49	 Index



		�  5

This guide shows you how to set up and maintain networked 
calendars for your organization using iCal Server, the 
calendar service for Mac OS X Server.

You will find information about setting up, managing, maintaining, and monitoring iCal 
service to use Apple’s iCal application or other CalDAV compliant calendar application, 
to access and share calendar events.

What’s New in iCal Server
Mac OS X v.10.6 iCal Server offers major enhancements in several key areas:

ÂÂ Directory compatibility:  LDAP and Active Directory systems no longer need 
directory modification to designate calendar users.

ÂÂ Mail notifications:  Event attendees without calendar accounts can now receive a 
mail message that provides event invitation information.

ÂÂ Private comments from attendees:  Event attendees can annotate the events with 
text that only they and the organizer can see.

ÂÂ Push notification:  Changes made to calendars and events can be reflected in  
clients immediately.

ÂÂ Server-side scheduling:  Event invitations are processed on the server, freeing the 
client for better performance.

ÂÂ Service discovery:  Clients can use DNS to track which servers are iCal servers.

ÂÂ Web client:  The server package now includes a built-in web-based calendar client.

Pr
ef
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What’s in This Guide
This guide includes the following chapters:

Chapter ÂÂ 1, “Understanding iCal Server,” provides an overview of iCal Server and  
how it is used.

Chapter ÂÂ 2, “Setting Up and Managing iCal Server,” provides instructions for setting 
up and managing iCal.

Chapter ÂÂ 3, “Advanced iCal Server Information,” provides detailed implementation 
information about the service.

Note:  Because Apple periodically releases new versions and updates to its software, 
images shown in this book may be different from what you see on your screen.

Using Onscreen Help
You can get task instructions onscreen in Help Viewer while you’re managing 
Mac OS X Server. You can view help on a server, or on an administrator computer.  
(An administrator computer is a Mac OS X computer with Mac OS X Server 
administrator software installed on it.)

To get the most recent onscreen help for Mac OS X Server:
Open Server Admin or Workgroup Manager and then:mm

Use the Help menu to search for a task you want to perform.ÂÂ

Choose Help > Server Admin Help or Help > Workgroup Manager Help to browse ÂÂ
and search the help topics.

The onscreen help contains instructions taken from Advanced Server Administration 
and other administration guides.

To see the most recent server help topics:
Make sure the server or administrator computer is connected to the Internet while mm

you’re getting help.

Help Viewer automatically retrieves and caches the most recent server help topics 
from the Internet. When not connected to the Internet, Help Viewer displays cached 
help topics.
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Documentation Map
Mac OS X Server has a suite of guides that cover management of individual services. 
Each service may depend on other services for maximum utility. The documentation 
map below shows some related guides that you may need in order to to fully 
configure iCal Server to your specifications.

You can get these guides in PDF format from the Mac OS X Server Resources website: 

www.apple.com/server/macosx/resources/

Getting Started
Covers basic

installation, setup,
and management of

iCal service using
Server Preferences.

Server
Preferences Help
Provides onscreen

instructions and answers
when you’re using Server
Preferences to manage

iCal service.

Advanced Server
Administration

Describes using Server Admin
to install, configure, and

administer server software
and services. Includes best

practices and advice for system
planning, security, backing up,

and monitoring.

iCal Server
Administration

Describes advanced
options for setting up,

configuring, and
managing iCal service.

Introduction to
Command-Line
Administration

Explains how to use
UNIX shell commands to
configure and manage

servers and services.

Server Admin Help
Provides onscreen

instructions and answers
when you’re using

Server Admin to set up
iCal service.

Web Technologies
Administration
Explains how to

set up a web server
to provide calendar

service in a web browser.

Network Services
Administration
Explains how to
set up proxy and
firewall for use

with iCal service.

http://www.apple.com/server/resources/
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Viewing PDF Guides Onscreen
While reading the PDF version of a guide onscreen:

Show bookmarks to see the guide’s outline, and click a bookmark to jump to the ÂÂ
corresponding section.

Search for a word or phrase to see a list of places where it appears in the document. ÂÂ
Click a listed place to see the page where it occurs.

Click a cross-reference to jump to the referenced section. Click a web link to visit the ÂÂ
website in your browser.

Printing PDF Guides
If you want to print a guide, you can take these steps to save paper and ink:

Save ink or toner by not printing the cover page.ÂÂ

Save color ink on a color printer by looking in the panes of the Print dialog for an ÂÂ
option to print in grays or black and white.

Reduce the bulk of the printed document and save paper by printing more than ÂÂ
one page per sheet of paper. In the Print dialog, change Scale to 115% (155% 
for Getting Started). Then choose Layout from the untitled pop-up menu. If your 
printer supports two-sided (duplex) printing, select one of the Two-Sided options. 
Otherwise, choose 2 from the Pages per Sheet pop-up menu, and optionally choose 
Single Hairline from the Border menu. (If you’re using Mac OS X v10.4 or earlier,  
the Scale setting is in the Page Setup dialog and the Layout settings are in the  
Print dialog.)

You may want to enlarge the printed pages even if you don’t print double sided, 
because the PDF page size is smaller than standard printer paper. In the Print dialog  
or Page Setup dialog, try changing Scale to 115% (155% for Getting Started, which has 
CD-size pages).
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Getting Documentation Updates
Periodically, Apple posts revised help pages and new editions of guides. Some revised 
help pages update the latest editions of the guides.

To view new onscreen help topics for a server application, make sure your server or ÂÂ
administrator computer is connected to the Internet and click “Latest help topics” or 
“Staying current” in the main help page for the application.

To download the latest guides in PDF format, go to the Mac OS X Server Resources ÂÂ
website at:  www.apple.com/server/macosx/resources/

An RSS feed listing the latest updates to Mac OS X Server documentation and ÂÂ
onscreen help is available. To view the feed, use an RSS reader application 
such as Safari or Mail and go to: feed://helposx.apple.com/rss/snowleopard/
serverdocupdates.xml

Getting Additional Information
For more information, consult these resources:

ÂÂ Read Me documents — get important updates and special information. Look for 
them on the server discs.

ÂÂ Mac OS X Server website (www.apple.com/server/macosx/)—enter the gateway to 
extensive product and technology information.

ÂÂ Mac OS X Server Support website (www.apple.com/support/macosxserver/)—access 
hundreds of articles from Apple’s support organization.

ÂÂ Apple Discussions website (discussions.apple.com/)—share questions, knowledge, 
and advice with other administrators.

ÂÂ Apple Mailing Lists website (www.lists.apple.com/)—subscribe to mailing lists so you 
can communicate with other administrators using email.

ÂÂ Apple Training and Certification website (www.apple.com/training/)—hone  
your server administration skills with instructor-led or self-paced training,  
and differentiate yourself with certification.

http://www.apple.com/server/resources/
feed://helposx.apple.com/rss/snowleopard/serverdocupdates.xml
feed://helposx.apple.com/rss/snowleopard/serverdocupdates.xml
http://www.apple.com/server/macosx/
http://www.apple.com/support/macosxserver/
http://discussions.apple.com/
http://www.lists.apple.com/
http://www.apple.com/training/
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Use this chapter to learn about iCal Server features, 
implementation, and integration.

iCal Server is the shared calendar service for Mac OS X Server. Built on open standard 
protocols, iCal Server provides integration with leading calendaring programs.

Now it’s easy to share calendars, schedule meetings, and coordinate events within a 
workgroup, a small business, or a large corporation. Built on open standard protocols, 
iCal service integrates with leading calendaring programs. iCal service doesn’t impose 
a per-user license, so your organization can grow without paying for additional licenses.

iCal Server Features
iCal service is Mac OS X Server’s complete calendaring solution for your organization’s 
needs. It has all the features you need for a full calendaring solution, including:

ÂÂ Attachments:  Events can have file attachments associated with them, so every 
event participant can have a copy of a file or meeting agenda.

ÂÂ Delegation (proxy) support:  Other users can be authorized to view your calendar 
events. This allows people to track subordinates, resources, or other designated 
calendar users. Proxies allow event scheduling delegation as well.

ÂÂ Directory support:  iCal service works with Open Directory and Active Directory to 
provide calendar service for users.

ÂÂ Mail notifications:  Event attendees without calendar accounts can now get a mail 
message with event invitation information.

ÂÂ Event invitations:  Users can invite others to an event. When the recipient 
acknowledges the invitation, the scheduler gets the RSVP.

ÂÂ Fine-grained access controls:  iCal service fully supports access control lists (ACLs) 
for events and attachments.

ÂÂ Free/Busy browsing:  When scheduling an event, a user can see if invitees are 
available to accept an invitation.

1Understanding iCal Server
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ÂÂ Location and resource scheduling:  Resources (projectors, cars, and so forth) and 
locations can have their own calendars and can be invited to events.

ÂÂ Multiple calendars:  Each person or resource can have multiple calendars. Users can 
organize their calendars however they choose.

ÂÂ Push notification:  Changes made to calendars and events can be reflected in  
clients immediately.

ÂÂ Server-side scheduling:  Event invitations are processed on the server, freeing the 
client for better performance.

Open Standards
iCal service is based on open standards. Each part of iCal service is a published 
standard. It’s built upon a strong foundation of proven standards and familiar 
technologies, including:

ÂÂ HTTP (RFC 2616):  HTTP serves as the method of communication between the 
calendar clients and the server.

ÂÂ WebDAV (RFC 4918):  WebDAV serves as iCal service’s method for reading and 
writing calendar files on the server.

ÂÂ CalDAV (RFC 4791):  CalDAV is an extension of WebDAV to provide features specific 
to calendaring (like searches for free/busy information and use of the invitation 
protocol iTIP).

ÂÂ iCalendar (RFC 2445):  iCalendar is the standard text format for describing events.

ÂÂ iTIP (RFC 2446):  iTIP is the standard for making and responding to event invitations.

Apple is a member of the Calendaring and Scheduling Consortium (CalConnect) and is 
committed to open standards-based calendaring and scheduling protocols. To further 
the widespread adoption and deployment of these standards, complete source code is 
released to the open source community as part of the Darwin Calendar Server project, 
hosted on the macosforge.org website, calendarserver.org.

Directory and Client Integration
iCal service is integrated with Mac OS X Server’s foundation technologies. Calendar 
users are authenticated from Open Directory and Kerberos. iCal service is available to 
Apple Wiki groups, with each having its own shared calender. The calendar files are 
stored in flat files so they can integrate with any storage system, local or networked.

In addition to Mac OS X Server technologies, iCal service can integrate with other 
directory systems like Active Directory or plain LDAP systems.

iCal service uses open calendaring protocols for integrating with leading calendar 
programs, including iCal 4 in Mac OS X v10.6, Mozilla’s Sunbird, OSAF’s Chandler,  
and Microsoft Outlook (using an open source connector).



Service Scalability
Because the technology is based on web standards, iCal service has all the scalability 
of Mac OS X Server’s world-class web services.

As your organization grows, iCal service can take advantage of standard scalability 
technologies such as network load distributors, storage networks, and distributed 
directory servers.

To maximize service scalability and minimize loss of productivity from service outages, 
iCal service is optimized for use with Xsan—Apple’s clustered file system. With Xsan, 
multiple calendar servers can read and write to the same volume, making it easy to 
increase performance and improve service reliability by scaling for additional servers.

Client Applications That Integrate with iCal Server
The following Apple applications can use iCal service. For a client to use iCal service, 
the client must support the CalDAV protocol.

ÂÂ iCal 4.0:  The version of iCal that ships with Mac OS X v10.6 has built-in support for 
CalDAV and therefore iCal service.

For more information on configuring iCal 4.0 for use with iCal Server, see 
“Supporting iCal 4.0 Client Users” on page 38 and iCal’s online help.

ÂÂ Apple built-in web calendar:  The wiki service has an online calendar for each wiki 
user that has iCal service enabled.

For more information on using the web client for iCal Server, open Server Admin 
and then use the Help menu to search for “wiki,” or see the Mac OS X Server 
Resources website at:

www.apple.com/server/macosx/resources/

Third-Party Applications
In addition, the following third-party applications can use iCal service. These 
applications are from companies or projects that have committed to using CalDAV as 
an open calendaring service. This list does not indicate an endorsement or support for 
any of the products listed.

Mozilla Sunbird and Lightning (open source)ÂÂ

Open Software Application Foundation Chandler (open source)ÂÂ

Microsoft Outlook using the open source Outlook Connector ProjectÂÂ

Mulberry (open source)ÂÂ

GNOME Evolution using the CalDAV plugin (open source)ÂÂ

Zidone (commercial plugin)ÂÂ

EMClient (Windows only commercial plugin)ÂÂ
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iCal Server In Action
The following illustration shows the iCal service in a common workgroup environment. 
iCal service is running on an Xserve connected to a shared storage system, Xsan. The 
Open Directory server authenticates the calendar users.

Calendar users view, make, and save calendars and calendar entries using iCal 4.0 (for 
Mac OS X v10.6 and later), or some other CalDAV compliant application. A Web server 
on the same network is running an Apple wiki server for a group with a shared group 
calendar. That same web server is also a client computer, accessing iCal service for the 
wiki calendar.

Web Server running
Apple’s Wiki Server

iCal Server with Xsan Storage

iCal Server back end iCal Server clients

Authentication servers

Mozilla’s Sunbird

OSAF’s Chandler

Snow Leopard with iCal 4.0
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Use this chapter to set up and manage iCal Server.

iCal Server is configured using Server Admin, authenticated using Open Directory, and 
accessed using any CalDAV compatible client.

This chapter provides the planning steps and tasks necessary to set up iCal Server.  
It also provides information about how to manage and monitor iCal Server.

iCal Server Minimum Requirements
To run iCal Server, you need:

A host name for the server, with full reverse DNS lookupÂÂ

A firewall rule that allows TCP connections from iCal Server clients to iCal Server on ÂÂ
a chosen port

User names and passwords stored in a directory service (such as a Mac OS X v10.5  ÂÂ
or later Open Directory system, or an Active Directory system)

(Optional) If you use Kerberos for authentication, a running Kerberos systemÂÂ

A functioning DNS system, with full reverse lookups, a firewall to allow configuration, 
and an Open Directory server for authentication constitute a bare minimum for the 
setup environment.

Setting Up iCal Server
iCal Server depends on other Mac OS X Server features. The following steps give the 
basic setup instructions and considerations for the first time you deploy iCal Server.

Step 1:  Plan your deployment
Make sure your target server meets the minimum Mac OS X Server system 
requirements. Make sure the number of servers is adequate for the estimated traffic. 
Make sure the storage space for calendars and attachments is sufficient for the 
estimated amount of data.

2Setting Up and Managing iCal 
Server
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Additional information that can help you make these storage decisions can be 
found in Chapter 3, “Advanced iCal Server Information” and “Planning for iCal Server 
Computing Resources” on page 17.

Step 2:  Gather your information
You need the following information before you begin:

Host name of the serverÂÂ

TCP port to respond to iCal Server connectionsÂÂ

Authentication method (Digest, Kerberos v5, or Any)ÂÂ

Location of the data storeÂÂ

Estimated maximum attachment sizeÂÂ

Estimated storage quota per userÂÂ

Certificate and port information for SSL connections (optional)ÂÂ

Gathering the information beforehand helps the installation go smoothly, and helps 
you make planning decisions.

Step 3:  Set up the environment and infrastructure
If you are not in complete control of the network environment (DNS servers,  
DHCP server, firewall, and so forth), coordinate with your network administrator  
before installing.

If you are planning on connecting the server to an existing directory system, you  
must also coordinate efforts with the directory administrator.

Before starting iCal Server, you must set up the following environment and 
infrastructure services:

Set up Server Admin to connect to the calendar server and administer the service.ÂÂ

For more information on configuring Server Admin, open Server Admin and 
then use the Help menu, or see the Mac OS X Server Resources website at 
www.apple.com/server/macosx/resources/.

If you use a directory service to authenticate users, make sure the directory service ÂÂ
is functional and the calendar server is bound to the directory.

For more information about creating and using a directory, open Workgroup 
Manager and then use the Help menu, or see the Mac OS X Server Resources 
website at www.apple.com/server/macosx/resources/.

Create Service (SRV) records in the DNS for CalDAV calendar service.ÂÂ

For more information about creating an SRV record, see “Configuring DNS for iCal 
Server” on page 19.

If you use SSL certificates to encrypt traffic, install the SSL certificate on the server ÂÂ
(and client as appropriate).



For more information on installing or creating certificates, open Server Admin 
and then use the Help menu to search for “certificate,” or see the Mac OS X Server 
Resources website at www.apple.com/server/macosx/resources/.

Configure the network firewall (and server firewall, if necessary) to allow  ÂÂ
iCal Server traffic.

For more information on configuring the firewall, open Server Admin and then use 
the Help menu to search for “firewall,” or see the Mac OS X Server Resources website 
at www.apple.com/server/macosx/resources/.

If you’re using a proxy service for mobile access, enable the calendar proxy server  ÂÂ
or get the calendar server proxy host name.

For more information on running your own calendar proxy service, open Server 
Admin and then use the Help menu, or see the Mac OS X Server Resources website 
at www.apple.com/server/macosx/resources/.

If you’re using push notification, enable the push notification service or get the  ÂÂ
push notification server host name.

For more information on running your own calendar push service, open Server 
Admin and then use the Help menu to search for “push notification,” or see the 
Mac OS X Server Resources website at www.apple.com/server/macosx/resources/.

Step 4:  Enable user calendar accounts
Users on a server or in a directory service get calendar service automatically, unless 
they are restricted. You can give resources and locations calendar accounts as well. If 
you are using Mac OS X Server v10.6 for your directory service, use Server Admin and 
iCal Server Utility to add iCal Server accounts to users, groups, locations, and resources.

By enabling iCal Server accounts for a user using Server Admin, you give the user 
service access control list (SACL) permissions to the calendar service.

Additionally, you can set the global calendar attachment file size quota.

For more information about enabling calendar service for iCal Server principals  
(users, groups, and resources), see the following sections:

“ÂÂ Creating the iCal Server’s Service Access Control List” on page 29

“ÂÂ Creating iCal Resources and Locations” on page 30

“ÂÂ Delegating Access to a User’s Calendar” on page 30

“ÂÂ Changing Calendar User Quotas” on page 25

Step 5:  Configure and start iCal Server
Configure the service parameters and turn on the iCal Server. As users log in to the 
service with their CalDAV-enabled calendar applications, the service creates the 
needed directories and files.
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For more information about enabling, configuring, and starting iCal Server, see the 
following sections:

“ÂÂ Understanding iCal Server Administration Settings” on page 22

“ÂÂ Changing the Calendar Data Store Location” on page 24

“ÂÂ Changing the Maximum Attachment Size” on page 24

“ÂÂ Setting the iCal Server Host Name” on page 25

“ÂÂ Setting the iCal Server Port Number” on page 26

“ÂÂ Enabling Mail Notifications to Attendees” on page 27

“ÂÂ Starting or Stopping iCal Server” on page 19

Planning for iCal Server Computing Resources
Before setting up iCal Server, you must plan for and allocate computing resources 
for the service. There are two main considerations in allocating resources to the 
service:  storage resources and processing and network load usage.

Storage Resources
Unless people attach files to event, disk space is not a problem with a calendaring 
system. Calendar events are at most a few KB of space, and even a full calender with  
a thousand events can total to less than 2 MB per calendar.

Typically the average calendar size is determined by:

The number of recurring eventsÂÂ

The number of attendees per eventÂÂ

Whether attachments are included in eventsÂÂ

Attachments are stored as separate files on the server with Uniform Resource 
Identifier (URI) pointers in the events. If you anticipate use of attachments you must 
reserve additional size.

As an example, let’s imagine a user who creates 8 one-hour, nonrepeating events per 
day for a year. This would be an extremely busy person. That would be 2,920 events.  
At a generous 5 KB each, that calendar is about 14 MB. So if you assume 15 MB per user 
per year, you would need about 1.5 GB per year for 100 users.

A good rule of thumb for needed storage is:

(15 MB + global user attachment quota) x (number of users) x (number of years of 
saved calendar data).

Processing and Network Load Resources
Because the protocol that carries the calendar information to and from the server is 
based on web standards, determining the number of servers needed and how much 
bandwidth is the same for a CalDAV server like iCal Server as it is for any web service.



Calendar clients query the calendar server with a wide array of HTTP methods (PUT, 
GET, PROPFIND, REPORT, ACL, PROPPATCH, and POST methods). Server-side processes 
collect and collate the calendar information to return to clients.

Therefore, plan your resources for iCal Server like you do for a web server. In general 
the average calendar server load is determined by:

The number of simultaneous activitiesÂÂ

The queries can be free-busy requests by people creating events and updating 
existing events.

The number of simultaneous activities isn’t the same as number of users. For 
example, if calendar users adjust their calendars less often, or at different times,  
the number of activities is lower.

The complexity of individual calendarsÂÂ

Calendars with greater complexity require slightly more computational power on 
the part of the server. The server collates multiple events, calculates future events 
from repeating events, and searches user records for attendee information.

iCal Server engages in prolific caching when not serving data, which moves time-
intensive computations to relatively slow periods of activity. This spreads the load 
across time and makes calendar queries as fast as possible. In general, calendar 
complexity is minor compared to the number of simultaneous calendar activities.

Enabling iCal Server Administration in Server Admin
You must turn on iCal Server administration before you can use Server Admin to 
configure or enable it. This allows Server Admin to start, stop, and change settings  
for iCal Server.

You don’t need to enable iCal Server administration if you plan on using the server 
administration command-line tool serveradmin instead of Server Admin.

To enable iCal Server for administration:
	 1	 Open Server Admin.

	 2	 Select a server, click the Settings button in the toolbar, and then click the Services tab.

	 3	 Select the checkbox for iCal Server.

From the command line:
sudo serveradmin settings info:serviceConfig:services:com.apple.

ServerAdmin.Calendar:configured = yes

The iCal Server is ready to configure and control using Server Admin.
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Starting or Stopping iCal Server
After you make configuration or user-provisioning changes, you must restart the  
iCal Server.

To start or stop iCal Server:
	 1	 Open Server Admin.

	 2	 Select a server, then click the service disclosure triangle to show the services for 
administration.

These instructions assume iCal Server was enabled in the service administration list  
of Server Admin.

	 3	 In the service list beneath the server, select iCal Server.

	 4	 Click Start iCal, the service start button below the server list.

If the service is running, click Stop iCal.

From the command-line:
sudo serveradmin start calendar

sudo serveradmin stop calendar

Configuring DNS for iCal Server
Mac OS X’s iCal application detects the host name of the calendar server. This allows 
the calendar client to populate configuration panels without unnecessary user effort.

iCal queries the DNS system for the service record (SRV) associated with CalDAV 
service. The DNS server returns the host name and port for connecting to the CalDAV 
service. The client application uses this information to populate the settings pane for 
the user’s account.

For automatic detection to work, you must create an SRV type DNS record for iCal 
Server. If you don’t have administrative access to the DNS system for your network, 
arrange the creation of the SRV record with your network administrator.

If the service uses SSL, one or two service types must be specified in DNS SRV entries 
(one for SSL, one without). Each type needs its own DNS entry with corresponding port.

Because DNS systems can be administered in many ways and on many platforms, this 
topic can’t give exact, step-by-step instructions for the creation of the record. This 
section contains only SRV record keys and values.

The record uses this format:

_Service._Protocol.Name. TTL Class SRV Priority Weight Port Target

The SRV record requires these settings:

ÂÂ Service: _caldav (_caldavs for SSL connections)



ÂÂ Protocol:  _tcp

ÂÂ Name:  The domain name that this record is valid for, followed by a period  
(for example, example.com.).

ÂÂ Class:  IN

ÂÂ Port:  8008, 8443 for SSL connections, or whichever port you define for the sevice. 
Don’t use the same port for _caldavs as you do for _caldav.

ÂÂ Target:  The calendar server’s fully qualified domain name, followed by a period  
(for example, calendar.example.com.).

SRV records cannot use aliases or CNAMEs as valid targets. The SRV record must 
point to an A record only.

The SRV records contain values which are not specified for the service operation,  
but are specific to your needs, such as the following:

ÂÂ TTL:  A DNS time to live number; for example, 86400 is 86400 seconds, or 1 day.

ÂÂ Priority:  The target host priority, where a lower value means the target is more 
preferred. For example, a target with priority 5 will have traffic routed to it before a 
target with priority 10.

ÂÂ Weight:  The relative weight for records with the same priority. For example, if server 
A’s weight is 10 and server B’s weight is 90, the DNS server points client requests to 
server B nine times more often than it points to server A.

For more information on round-robin priority weighting, see “iCal Server Scaling”  
on page 45.

An iCal Server SRV record in a DNS configuration file would look like this:

_caldav._tcp.example.com. 86400 IN SRV 0 0 8008 calendar.example.com.

The SRV record above indicates a calendar server at calendar.example.com, listening on 
tcp port 8008, whose record can be cached for 1 day. If there were multiple calendar 
servers, the priority and weight numbers would be something other than zero.

Important:  Although Mac OS X Server v10.6 has a powerful, fully functional DNS 
system and can provide SRV records, the Server Admin interface to the DNS system 
doesn’t create the correct format of SRV record for this use. You must edit the DNS 
configuration files by some other means.

If you want to edit the DNS system running on a Mac OS X Server v10.6, you must edit the 
zone record files manually via the command-line. Doing so is not recommended for 
administrators without previous experience administering DNS BIND 9 on Mac OS X Server.

To edit the DNS files for iCal Server
You must edit a file for each zone that needs an SRV record. The zone files are located 
at (where <domain.tld> is the domain name and top level domain of the zone):

/var/named/db.<domain.tld>.
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The zone file contains an “include” line of code that programmatically inserts the contents 
of a file managed by Server Admin at /var/named/zones/db.<domain.tld>.zone.apple in 
the zone file. Do not alter or remove the “include” line.

If you make additions, place them at the end of the file.

This code block is the information in the Server Admin managed zone file at 
/var/named/zones/db.<domain.tld>.zone.apple. It is presented here as if it were in  
the file located at /var/named/db.<domain.tld>. so you can see the A records that  
are referenced in the SRV records.

The following sample gives in-code comments and examples of configuration settings. 

;GUID=<GUID here>

$TTL 10800        ; default expiration time of a record

example.com. IN SOA ns.example.com. username.example.com. (

     2009031903    ;Serial

     86400         ;Refresh

     3600          ;Retry

     604800        ;Expire

     345600        ;Negative caching TTL

     ) 

example.com.  IN  NS    ns.example.com.

; "ns.example.com" is the name server for the domain "example.com"

example.com.  IN  A     10.0.0.1        

; the IP address for "example.com"

ns                A     10.0.0.2        

; ip address for "ns.example.com"

name              CNAME ns              

; "name.example.com" is another name for for "ns.example.com"

calendar      IN  A     10.0.0.12       

; the IP address for "calendar.example.com"

                  TXT   "The iCal Server that we're using" 

; text explanation of server

ical          IN  CNAME calendar.example.com. 

; "ical.example.com" is another name for "calendar.example.com"

calendar2     IN  A     10.0.0.13        

; the IP address for "calendar2.example.com"

                  TXT   "a backup iCal Server"

; text explanation of server

;

; Here you begin the lines which are the necessary SRV record

; for the calendar service. See the in-code comments.



;

_caldav._tcp.example.com.  86400 IN SRV 0 0 8008 calendar.example.com.

; the above line could also be--

; _caldav._tcp  86400 IN SRV 0 0 8008 calendar.example.com.

; or even--

; _caldav._tcp  86400 IN SRV 0 0 8008 calendar

;

; the following line makes "calendar2.example.com" a round robin

; with lower priority when "calendar.example.com" is down

_caldav._tcp.example.com. 86400 IN SRV 1 0 8008 calendar2.example.com.

;

; the following two lines show the previously described

; calendar servers using SSL for security

_caldavs._tcp.example.com. 86400 IN SRV 0 0 8443 calendar.example.com. 

_caldavs._tcp.example.com. 86400 IN SRV 1 0 8443 calendar2.example.com. 

Understanding iCal Server Administration Settings
The following settings are available for customization using Server Admin:

Setting Description

Data store This is where the server stores all user calendars, 
delegate lists, and event attachments.

To change this setting, see “Changing the 
Calendar Data Store Location” on page 24.

Maximum attachment size This is the maximum file size (in MB) for each 
event attachment.

To change this setting, see “Changing the 
Maximum Attachment Size” on page 24.

User quota This is the total size of all user calendars and 
event attachments.

To change this setting, see “Changing Calendar 
User Quotas” on page 25.

Log Level This setting changes how much information is 
recorded in service logs.

To change this setting, see “Setting Logging 
Levels” on page 34

Push Notifications This is the server that sends calendar updates to 
mobile clients.

To change this setting, see “Setting the iCal Push 
Notification Server” on page 26.
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Setting Description

Wiki Server This is a wiki server whose calendars are hosted 
by the iCal Server.

To change this setting, see “Make iCal Server Host 
a Wiki Server’s Calendar” on page 33.

Enable Email Notifications This setting allows the calendar server to send 
and receive event notifications via email.

To change this setting, see “Enabling Mail 
Notifications to Attendees” on page 27.

Authentication Type This is the authentication method required for 
calendar access.

To change this setting, see “Configuring Security 
for iCal Server” on page 31.

Host name This is the fully qualified domain name in DNS.  
It should be in the reverse lookup domain as well.

To change this setting, see “Setting the iCal Server 
Host Name” on page 25.

Port This is the HTTP port number that iCal Server 
uses for connections. The default port for non-SSL 
connections is 8008.

To change this setting, see “Supporting iCal 4.0 
Client Users” on page 38.

SSL (Secure Sockets Layer) and certificate chooser Choose a pop-up setting to require or allow SSL 
to encrypt network traffic between the calendar 
server and clients. After selecting, choose the 
certificate to use. The Default port is 8443.

To change this setting, see “Configuring 
and Enabling Secure Network Traffic for iCal 
Server” on page 32.

SSL Port When SSL is selected, choose your SSL port.  
The Default port is 8443.

To change this setting, see “Configuring 
and Enabling Secure Network Traffic for iCal 
Server” on page 32.

If you prefer to administer the service from the command-line, you can use the 
serveradmin tool. See the serveradmin man page for the syntax description.

For an introduction to using the command line for administration, see the 
Mac OS X Server Resources website at www.apple.com/server/macosx/resources/.



Changing the Calendar Data Store Location
The data store is where the server stores user calendars and event attachments.  
The default location is /Library/CalendarServer/Documents/. If you change the data 
store location, you must set the proper permissions on the new data store location.

This location is relative to the local file system, so if the storage location is on a 
network volume, enter the local filesystem mount point and not a network URL.

If you have a data store fully populated with user calendars, you must move the files 
when you change the location. To see how to move the files, see “Understanding the 
Data Store and File Hierarchy for iCal Server” on page 42.

To change the default data store:
	 1	 Create the folder for the data store.

	 2	 Set the ownership and permissions of the new data store to match the previous location.

	 3	 In Server Admin, select a server and choose iCal Server.

	 4	 Click the Settings button in the toolbar, then click the General tab.

	 5	 In the Data Store field, enter the new location.

Alternately, click the Choose button and navigate to the new location.

	 6	 Click Save, then restart the service.

From the command-line:
sudo mkdir <new path>

sudo chown _calendar:_calendar <new path>

sudo chmod 740 <new path>

sudo serveradmin set calendar:DocumentRoot = "<new path>"

Changing the Maximum Attachment Size
Each event on a calendar can have files attached to it. All invitees to the event can 
access the attachments.

The maximum attachment size is the maximum total size of all attachments for an 
event. There is no limit to the total number of files attached to a single event except 
for the calendar user’s storage quota.

To set the attachment size limit:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, then click the General tab.

	 3	 In the Maximum Attachment Size field, enter the file size (in MB).

	 4	 Click Save, then restart the service.
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From the command-line:
sudo serveradmin set calendar:MaximumAttachmentSize = <file size in 

bytes, default is 1048576> 

Changing Calendar User Quotas
Each calendar user has a disk quota. This quota is the total possible size of all the user’s 
calendars and event attachments.

Quotas are not set on a per-user basis. They are set globally for all users. Do not allow 
the total of all your users’ quotas to exceed the storage capacity of the data store.

To change the user quota:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, then click the General tab.

	 3	 In the User Quota field, enter the quota amount (in MB).

	 4	 Click Save, then restart the service.

From the command-line:
sudo serveradmin set calendar:UserQuota = <file size in bytes, default is 

104857600> 

Setting the iCal Server Host Name
When setting up iCal Server, you specify the host name of the iCal server. It should be 
a fully qualified domain name matched with a reverse lookup record. If left blank, the 
calendar server defaults to the local hostname.

Be sure the change you make here is reflected in the DNS SRV records.

To set the host name:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, then click the Authentication tab.

	 3	 In the Host Name field, enter the host name.

	 4	 Click Save, then restart the service.

From the command-line:
sudo serveradmin set calendar:ServerHostName = "<host name, for example 

cal.example.com>" 



Setting the iCal Server Port Number
When setting up iCal Server, the server is set to use TCP port 8008. You can change  
the port in Server Admin.

Be sure to make the relevant changes to your firewall to allow network access to  
the server.

To set the port number:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, then click the Authentication tab.

	 3	 In the HTTP Port Number field, enter the port number.

	 4	 Click Save, then restart the service.

From the command-line:
sudo serveradmin set calendar:HTTPPort = <port number, default for non-

SSL is 8008> 

Setting the iCal Push Notification Server
Apple’s iCal Server supports push notification for calendar invitations and events. Instead 
of having the calendar client constantly access the calendar server to search for new 
event invitations, the client maintains a very light network connection and the server 
informs the client if the client has received an event invitation, or if an event has changed.

Be sure to make the relevant changes to your firewall to allow network access to the 
push notification server.

If push notification is configured on the server, it is listed in the relevant location on the 
iCal Server settings pane. You can use these instructions to specify a different server.

To set the push notification server for the first time:
	 1	 If Push Notification service isn’t running on another computer for the network running 

Mac OS X Server v10.6, activate Push Notification on the iCal Server.

	 a	 In Server Admin, select the server and choose Push Notification.

	 b	 Click Settings in the toolbar, and select Start Push Notification.

	 2	 In Server Admin, select a server and choose iCal Server.

	 3	 Click the Settings button in the toolbar, then click the General tab.

	 4	 Click Add near the push notification setting area.

	 5	 In the new sheet, enter the new host name of the push notification server, an 
administrator’s name and password for the push notification server, and then click Ok.

If the push notification server is the same server as the calendar server, do not use 
“localhost” as the host name. Use the full DNS name instead.

	 6	 Click Save, then restart the service.
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To change the existing push notification server:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, then click the General tab.

	 3	 Select Remove near the push notification area.

	 4	 In the new sheet, enter the new host name of the push notification server, specify an 
administrator’s name and password for the push notification server, and then click Ok.

	 5	 Click Save, then restart the service.

From the command-line:
# on the notification server

sudo serveradmin start notification

# on the iCal Server

sudo serveradmin set calendar:Notifications:Services:XMPPNotifier:Host = 
"<hostname>"

Enabling Mail Notifications to Attendees
Attendees can be invited via email if they don’t have an iCal Server account. Mail 
notification is not available for users with iCal Server access on the calendar service.

When an event attendee is added by email address and the host name of the email 
address is not the same host name as the calendar server, iCal Server can send a 
message to the attendee with the event information. iCal Server must have its mail 
account in the mail system.

iCal Server must be able to send mail to an outgoing mail server (an SMTP server) for 
relay, so you need the SMTP server host name and listening port. You must also make 
sure there are no firewalls blocking access to the mail server from the calendar server. 
The SMTP server must be configured to relay mail from the calendar server as well.

iCal Server also requires access to an incoming mail server, either POP or IMAP, for 
invitation notifications.

These instructions assume the mail servers are configured and functioning.

To enable mail notifications
	 1	 Create an email user account in the mail system and make note of the mail address, 

account name, and password.

For example, the iCal Server could access the account “ical_server@example.com.”

If you need help creating a user account and giving it mail access, open Server Admin 
and then use the Help menu, or see the Mac OS X Server Resources website at 
www.apple.com/server/macosx/resources/.

	 2	 Get the following settings for the incoming mail server from the mail administrator:

Server protocol (for example, POP or IMAP)ÂÂ



Host name (for example, mail.example.com)ÂÂ

Listening port (for example, 143)ÂÂ

User name and password (for example, a user name like ical_server@example.com)ÂÂ

Whether the server is using SSL for connection securityÂÂ

 If you need help setting up an incoming mail server, open Server Admin and then 
use the Help menu to search for “mail server,” or see the Mac OS X Server Resources 
website at www.apple.com/server/macosx/resources/.

	 3	 Get the following settings for the outgoing (SMTP) mail server from the mail administrator:

Host name (for example, smtp.example.com)ÂÂ

Listening port (for example, 25)ÂÂ

Whether the server is using SSL for connection securityÂÂ

The authentication method and if it’s required (for example, CRAM-MD5 or Kerberos)ÂÂ

User name and password (for example, a user name like ical_server@example.com.ÂÂ

 If you need help setting up an outgoing mail server, open Server Admin and then 
use the Help menu to search for “outgoing mail server,” or see the Mac OS X Server 
Resources website at www.apple.com/server/macosx/resources/.

	 4	 In Server Admin, select a server and choose iCal Server.

	 5	 Click the Settings button in the toolbar, and click the General tab.

	 6	 Click Enable Email Invitations.

If you have previously set up mail invitation settings, click Edit.

	 7	 Fill out the mail server information that you have previously gathered, and click OK.

	 8	 Click Save, then restart the service.

From the command-line:
sudo serveradmin set calendar:Scheduling:iMIP:Enabled = yes

sudo serveradmin set calendar:Scheduling:iMIP:Receiving:Server = "<mail 
server host name>" sudo serveradmin set calendar:Scheduling:iMIP:Rec
eiving:UseSSL = <yes or no>

sudo serveradmin set calendar:Scheduling:iMIP:Receiving:Username = "<iCal 
Server's user name>"

sudo serveradmin set calendar:Scheduling:iMIP:Receiving:Type = "<POP or 
IMAP>"

sudo serveradmin set calendar:Scheduling:iMIP:Receiving:Password = 
"<plaintext password>"

sudo serveradmin set calendar:Scheduling:iMIP:Receiving:Port = <POP or 
IMAP port number>

sudo serveradmin set calendar:Scheduling:iMIP:MailGatewayServer = 
"localhost"

sudo serveradmin set calendar:Scheduling:iMIP:MailGatewayPort = 62310
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sudo serveradmin set calendar:Scheduling:iMIP:Sending:Server = "<SMTP 
hostname>"

sudo serveradmin set calendar:Scheduling:iMIP:Sending:Port = <SMTP port 
number>

sudo serveradmin set calendar:Scheduling:iMIP:Sending:Address = "<iCal 
Server's user name>"

sudo serveradmin set calendar:Scheduling:iMIP:Sending:Port = <SMTP port 
number>

Creating the iCal Server’s Service Access Control List
You determine if a user can authenticate to an iCal Server by adding him or her to a 
group called com.apple.access_calendar. You can use the Server Admin service access 
feature to add the users and groups to the group.

You can also use Workgroup Manager or Server Preferences to add calendar 
permissions to a user, so the user gets the correct service access control list (SACL) 
setting for calendar use automatically.

To add iCal Server for a user or group:
	 1	 Open Server Admin and select the server from the Servers list.

	 2	 Click Access.

	 3	 Make sure “For all services” or “iCal Server” is selected from the Service list.

“For all services” makes changes to all services. Selecting “iCal Server” only changes the 
SACL for iCal Server.

	 4	 To provide unrestricted access to iCal Server, click “Allow all users and groups.”

	 5	 To restrict access to specific users and groups:

	 a	 Select “Allow only users and groups below.”

	 b	 Click the Add (+) button to open the Users & Groups drawer.

	 c	 Drag users and groups from the Users & Groups drawer to the list.

From the command-line:
# Adding user to the group

dseditgroup -o edit -n /LDAPv3/<LDAP server hostname> -u <directory admin 
username> -p -a <username> -t user com.apple.access_calendar

# Adding a group to the group

dseditgroup -o edit -n /LDAPv3/<LDAP server hostname> -u <directory 
admin username> -p -a <group to be added> -t group com.apple.access_
calendar

# In both cases, you must provide the directory administrator password



Creating iCal Resources and Locations
Users and groups aren’t the only parts of a calendaring system. Resources like 
projectors, microscopes, or cameras, and locations like conference rooms or buildings 
must be scheduled, but they can’t keep their own calendar.

These resources and locations act much like users and groups. They accept event 
invitations, and they have free-busy time. Therefore they exist as principal entities on 
the calendar server for other users and groups to include in event invitations.

iCal Server Utility adds calendars for resources and locations to the iCal server, and lets 
you choose delegates for resource and location calendars.

To use resources and locations with iCal Server, you need an Open Directory Master 
to hold the resource and location records. If users aren’t authenticating to an Open 
Directory system (for example, if they are authenticating to an Active Directory 
system), the resource and location records must be in an Open Directory Master server, 
which is bound to the users’ directory system.

For additional information, see the iCal Server Utility help. The help contains detailed 
instructions, field descriptions, and guidance for setting up resources and locations.

To create an iCal Server resource or location:
	 1	 Open iCal Server Utility.

	 2	 Authenticate to the directory as the directory administrator.

	 3	 Select File > New > Resource or Location

	 4	 Fill out the information about the resource or location to be added to iCal Server.

For resources, remember to add an owner’s contact information.

For locations, remember to add a map using a graphic file.

	 5	 Click Save.

Delegating Access to a User’s Calendar
Every user can create and remove calendar events in his or her calendars in iCal Server. 
When users want to have someone else edit their personal calendars, they delegate (or 
assign a proxy for) calendar management.

iCal Server supports calendar viewing and editing delegates, allowing designated 
persons to read or write a user’s calendars.

Calendar delegation is not configured on the server side. To set up a user or group 
delegate, you use calendar client software. You use iCal Server Utility to you choose 
delegates for resource and location calendars.

To learn how to configure calendar delegation, see the documentation for your 
calendar client.
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Configuring Security for iCal Server
Security for iCal Server consists of two main areas:

ÂÂ Securing the authentication:  This means using a method of authenticating users 
that is secure and doesn’t transmit login credentials in clear text over the network. 
The high-security authentication used pervasively in Mac OS X Server is Kerberos v5.

To learn how to configure secure authentication, see “Choosing and Enabling Secure 
Authentication for iCal Server” on page 31.

ÂÂ Securing the data transport:  This means encrypting the network traffic between 
the calendar client and the calendar server. When the transport is encrypted,  
no one can analyze the network traffic and reconstruct the contents of the calendar. 
iCal Server uses SSL to encrypt the data transport.

To learn how to configure and enable SSL for iCal Server, see “Configuring and 
Enabling Secure Network Traffic for iCal Server” on page 32.

Choosing and Enabling Secure Authentication for iCal Server
Users authenticate to iCal Server through one of the following methods:

ÂÂ Kerberos v.5:  This method uses strong encryption and is used in Mac OS X for 
single sign-on to services offered by Mac OS X Server. It is the recommended 
authentication method supported by Mac OS X Server v10.6. Selecting this method 
requires the exclusive use of Kerberos authentication.

ÂÂ Digest:  (RFC 2617) This is HTTP Digest access authentication. It features good 
encryption of user passwords over the network without the use of a trusted  
third-party (like the Kerberos realm), and is usable without maintaining a Kerberos 
infrastructure. Selecting this method requires the exclusive use of  
Digest authentication.

ÂÂ Any:  This allows the maximum flexibility by accepting any authentication type. This 
includes Kerberos v.5 and Digest authentication. The client can choose the most 
relevant method for what it can support. Selecting this method allows the use of 
Digest or Kerberos authentication.

You can set the required authentication method using Server Admin. To enable the 
highest security, choose “Kerberos.”

To use Kerberos authentication, you must have an existing Kerberos password 
authentication and encryption system in place for users. If you use Kerberos, make the 
relevant changes to your firewall to allow network access to the Kerberos server from 
the calendar server.

Digest authentication requires no additional configuration.



To choose an authentication method:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, then click the Authentication tab.

	 3	 Select the method from the Authentication pop-up menu.

	 4	 Click Save, then restart the service.

From the command-line:
sudo serveradmin set calendar:Authentication:Digest:Enabled = yes

sudo serveradmin set calendar:Authentication:Kerberos:Enabled = yes

sudo serveradmin set calendar:Authentication:Kerberos:ServicePrincipal = 
""

sudo serveradmin set calendar:Authentication:Wiki:Enabled = yes

sudo serveradmin set calendar:Authentication:Basic:Enabled = no 

Configuring and Enabling Secure Network Traffic for iCal Server
When you enable Secure Sockets Layer (SSL), you encrypt all data sent between the 
iCal server and the client.

To enable SSL, you must select a Certificate. If you use the default self-signed 
certificate, the clients must choose to trust the certificate before they can make a 
secure connection.

You can choose to use or redirect SSL access. Choosing to use SSL access allows the 
iCal Server to accept connections from the unencrypted and encrypted SSL ports. 
Redirecting SSL access makes iCal server listen for and accept connections over the 
designated SSL port, and redirects requests for the HTTP port and sends them to  
the HTTPS port.

To enable secure network traffic using SSL transport:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, and then click the Authentication tab.

	 3	 In the pop-up menu, select Use, or Redirect to enable SSL.

If you select Don’t Use, SSL access is disabled.

	 4	 Choose the certificate to be used for encryption.

	 5	 Choose a TCP port for SSL to communicate on.

The default port is 8443.

	 6	 Click Save, then restart the service.

From the command-line:
sudo serveradmin set calendar:SSLPort = "<port number; default is 8443>"

sudo serveradmin set calendar:SSLCertificate = "/etc/
certificates/<location of pem SSL certificate>"
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sudo serveradmin set calendar:SSLPrivateKey = "/etc/
certificates/<location of pem private key>"

sudo serveradmin set calendar:SSLAuthorityChain = "/etc/
certificates/<location of key's authority chain>"

# The following line is necessary if you want to sets SSL transport to 
Redirect instead of Use

sudo serveradmin set calendar:RedirectHTTPToHTTPS = "yes"

Make iCal Server Host a Wiki Server’s Calendar
An iCal Server can host personal calendars for another Mac OS X Server v10.6 
computer that is offering wiki service.

When Mac OS X Server v10.6 computer is running Wiki Server, the “My Page” starting 
point for wiki users can link to a built-in web calendar. The web calendar is a client for 
iCal Server and reads and writes to a user’s CalDAV account calendar. However, the 
computer providing the wiki service doesn’t have to also provide calendar service.  
You can designate a different server to act as the calendar server.

You might want to do this because:

You choose to spread services across several servers.ÂÂ

You have a calendar server and are adding wiki service.ÂÂ

You have a large, distributed calendar server infrastructure, and moving service on ÂÂ
to the web server is impractical.

When you set up iCal Server to provide the calendar service for a wiki, Wiki Server 
provides access to the calendars, so users who do not have wiki privileges do not have 
calendar service.

To provide calendars for a designated wiki server:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, and then click the General tab.

	 3	 Enter the DNS host name or IP address of the Wiki Server.

	 4	 If SSL is used by the Wiki Server, check Use SSL.

	 5	 Click Save.

From the command-line:
sudo serveradmin set calendar:Authentication:Wiki:Enabled = "yes"

sudo serveradmin set calendar:Authentication:Wiki:Hostname = "<DNS name 
of Wiki server>"

sudo serveradmin set calendar:Authentication:Wiki:UseSSL = "<yes or no>"



Monitoring iCal Server
To keep iCal Server operating smoothly, you must monitor service logs. The service’s 
overview pane in Server Admin shows you the service start time, service state,  
and requests per hour. 

The following sections contain more information about monitoring iCal Server:

Viewing iCal Server Logs
iCal Server keeps two logs:  one for access and one for errors. You can view and filter 
the logs to troubleshoot the service or monitor service reliability.

To view the logs:
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Logs button in the toolbar.

	 3	 Select a log from the View pop-up menu.

	 4	 Filter the log for specific text strings by using the text filter field.

From the command-line:
sudo tail -F /var/log/caldavd/error.log

sudo tail -F /var/log/caldavd/access.log

Setting Logging Levels
iCal Server keeps two logs:  one for access and one for errors. You can view and filter 
the logs to troubleshoot the service or monitor overall service reliability.

You can configure logs to give more tailored information. The settings usually range 
from very verbose (reporting everything that’s happening in the server) or very quiet 
(reporting only the most dire errors). Apple’s iCal Server has several possible log levels:

Log level key Log level description

Error Logs only critical errors. This produces the least amount of output, 
but it is more focused on problems.

Warning Logs all errors, including innocuous errors like timeouts, and 
includes critical errors. 

Info Logs normal operating actions as well as errors. This is a fairly 
detailed log.

Debug Logs all information of everything to miniscule detail. Use this 
setting only for debugging purposes, and then set it back to 
another level after the log capture is complete.
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To set the log level
	 1	 In Server Admin, select a server and choose iCal Server.

	 2	 Click the Settings button in the toolbar, and then click the General tab.

	 3	 Select the log level from the pop-up menu.

	 4	 Click save.

From the command-line:
sudo serveradmin set calendar:DefaultLogLevel = "<log level key; default 

is 'info'>"

Rotating iCal Server Access Logs
Service logs sometimes require archiving. Rotating the logs regularly can improve 
performance in searching the logs and reduce used disk space. Enabling this setting 
allows logs to be archived and refreshed.

To set the logs to rotate:
sudo serveradmin set calendar:RotateAccessLog = yes

Maintaining iCal Server
The following sections contain information that assists an iCal Server administrator in 
keeping iCal Server working smoothly.

Understanding iCal Server Administration Configuration Files
You should administer iCal Server using Server Preferences, Server Admin, or the 
serveradmin tool. If Server Admin, or serveradmin are unavailable, you can configure 
and run iCal Server from the command-line, using built-in tools.

The following files are used to run iCal Server:

ÂÂ /etc/caldavd/caldavd.plist:  The main configuration file for caldavd

The file contains an XML property list of server options and provides such 
information as the port to bind to and whether to use SSL. You can specify the 
names of other files.

ÂÂ /var/log/caldavd/access.log:  The server’s main log file

ÂÂ /var/run/caldavd.pid:  The server’s process ID file

ÂÂ /usr/share/caldavd:  Implementation and support files



Understanding Calendar Files
Each calendar event is stored as an .ics file in the main data store. These .ics files can be 
affected by data corruption due to disk errors or software bugs that can disrupt service.

iCal Server also maintains sqlite database files at various levels of the file hierarchy to 
speed data retrieval. To troubleshoot or resolve problems, an administrator can inspect 
these files.

You can inspect or test event and calendar .ics files for file integrity, and remove them 
if they are corrupt. Additionally, sqlite databases used by the service are disposable, 
and are recreated as needed. You can use the built-in sqlite command-line tools to 
query or test the database files, or you can delete them. They are rebuilt when needed.

To access the files, you need root access to the /Library/CalendarServer/Documents/ 
folder and its subfolders (or whatever path you configured using Server Admin).

For more information about the calendar file hierarchy, see Chapter 3, “Advanced iCal 
Server Information.”

Backing Up and Restoring Calendar Files
In addition to backing up the configuration files listed in “Understanding iCal Server 
Administration Configuration Files” on page 35, you should back up the data store. The 
location of the data store is shown in the Settings tab of the iCal Server administration 
pane of Server Admin.

Because iCal Server files are flat files, you can use any backup procedure you want to 
save the files. You should maintain the original files’ POSIX permissions and ACL entries. 
Your backup solution must preserve extended attributes.

You don’t need to back up calendar database files in the file hierarchy. They are 
disposable.

Your backup software needs root access to the /Library/CalendarServer/Documents/ 
folder (or whatever path you configured using Server Admin) and its subfolders to 
back them up.

Mac OS X Server provides several command-line tools for data backup and restoration:

ÂÂ rsync -E. Use to keep a backup copy of your data in sync with the original. The -E 
flag is mandatory because it preserves file extended attributes. The rsync tool only 
copies files that have changed, but always copies extended attributes.

ÂÂ ditto. Use to perform full file-level backups.

ÂÂ asr. Use to back up and restore an entire volume at disk block-level. If asr degrades 
to file copy mode, rather than block copy mode, it does not copy necessary 
extended attributes. Make sure asr is performing a block copy, not a file copy.
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ÂÂ cp and scp. Use these tools to copy files and preserve extended attributes needed 
for iCal Server.

ÂÂ tar, pax, and gzip. Use these tools to archive and compress data for use with  
iCal Server.

The Mac OS X v10.6 Time Machine feature is not recommended for server file 
and system backup. If Time Machine backup is enabled, it saves the configuration 
information and status only; none of the calendars or attachments are saved.

Note:  You can use the launchctl command to automate data backup using the 
mentioned commands. For more information about using launchd, see its man page.

Deleting Unused Calendars
For security, privacy, or disk usage reasons, you might need to delete unused calendars. 
After calendar files and folders are created in the data store, they are not removed 
when a user, group, or resource is removed from the directory. This could potentially 
cause unintended service behavior if a user, group, or resource is created at a future 
time with the same name as the defunct one.

Important:  Before deleting any file, familiarize yourself with the data store file 
hierarchy. See “Understanding the Data Store and File Hierarchy for iCal Server” on 
page 42 before proceeding. Delete files only with extreme caution.

When a user, group, or resource is no longer actively using the calendar, you can easily 
delete the files, which include calendars, events, to-do lists, and attachments. To do so, 
delete the user folder from the data store manually.

If you delete the files for security or privacy reasons, use a secure-delete tool like the 
Mac OS X command-line tool srm. For command usage, see the srm man page.

To delete the files, you need root access to the /Library/CalendarServer/Documents/ 
folder and its subfolders.



Supporting iCal 4.0 Client Users
This section contains several basic tasks that iCal client users perform while using 
their iCal Server account. If you are using a calendar application that is not iCal, 
these instructions do not work:  they are for the iCal application provided with 
Mac OS X Server v10.6. 

Using the Subscribe feature in iCal 4.0 to subscribe directly to a CalDAV calendar is not 
supported. Likewise, subscribing to a Wiki user’s web calendar is also not supported.

Account Settings for iCal Client
In order to add a iCal Server account to iCal, you must know the following settings 
for the user name and calendar server location. Some of these settings are usable by 
other CalDAV clients.

For all accounts:
The iCal Server domain nameÂÂ

This domain name is the fully qualified domain name of the calendar server  
(for example, cal.example.com).

You can use only the domain name (for example, example.com) if the domain has 
an SRV DNS record for calendar service.

The iCal Server port numberÂÂ

This is the TCP port that the iCal Server is listen on.

Whether the iCal Server uses SSL encryption or notÂÂ

The calendar account location for account creationÂÂ

If automatic discovery fails, the account URL is http://server:port/principals/
users/username/

If the calendar client doesn’t support automatic discovery (like Mac OS X v10.5 iCal 
3.0), the account URL is http://server:port/calendars/__uids__/<<GUID>> 
where GUID is the user’s globally unique identifier.

For a user calendar account:
The calendar user’s short nameÂÂ

For example, John Doe might have “johndoe” as a short name.

The calendar user login nameÂÂ

The calendar user login name takes the form of <calendar user’s short name>@< 
iCal Server domain name> in iCal.
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Optional:  The user GUIDÂÂ

The user GUID is a Distributed Computing Environment (DCE) compatible 
universally unique identifier string created by the directory service for a user when 
his or her directory record is created.

It usually looks something like this:  95432C72-0035-4399-9447-8531601AA699.

Adding an iCal Server Account to an iCal Client
If your calendar is hosted on a CalDAV server (for example, through your workplace) 
you must set up your account in iCal so that it can share information with the  
CalDAV server.

Adding a calendar account to an iCal client
	 1	 Choose iCal > Preferences, and then click Accounts.

	 2	 Click the Add (+) button in the bottom-left corner of the preferences pane to add  
an account.

	 3	 In the Description field, enter a short, meaningful description of the calendar  
(for example, “Work Calendar”).

	 4	 In the Username and Password fields, enter the user name (in the form <user_short_
name>@<calendar server domain>) and your user password, and then click Add.

It should automatically find the calendar account at:  http://<calendar_server_
domain:port>/principals/users/<user_short_name>/

If it does not, enter the following location manually in the calendar account 
location:  http://<calendar_server_domain:port>/principals/__uids__/<user GUID>/

	 5	 In the Refresh Calendars pop-up menu, specify how often you want your computer 
to update the information it shares with the server (for example, to look for meeting 
invitations or update changes you’ve made to your calendar).

	 6	 Set the general times that you want to be available for meetings and events.

For example, if you work part time and want coworkers to schedule meetings with you 
only on weekdays between noon and 5:00 p.m., select Weekdays and enter the times 
in the adjacent fields.

If your availability includes weekends or only some weekdays, select Custom, click Edit, 
and then make selections to set your availability.



Creating a Calendar on an iCal Server Using iCal Client
You can create separate calendars for different areas of your life (work, home, school, 
and so on). iCal client makes it easy to make new calendars. If you are using some 
other calendar client (like Sunbird or Outlook), consult that application’s help to create 
a calendar.

Creating a calendar
	 1	 In the calendar source list, select the default calendar under the CalDAV account name.

If you do not select the default calendar under the CalDAV account, the calendar is 
created locally, not on the iCal server.

	 2	 At the bottom of the iCal window, click the Add (+) button.

	 3	 Enter a name for your calendar and press the Return key.

Setting a Delegate Using iCal Client
A read-only delegate is another user who can see your calendar items, including  
free-busy times, but not change them. Sometimes this is called a “proxy user.”

This setting is useful for locations and resources. If you make a user or group a read-
only delegate for the resource, the delegate can see the details of the resource’s use, 
rather than just whether the resource is busy.

Delegates can also be made to read and write to your calendar. You might have 
another person who you want to allow to add to or delete events on your calendar. 
This is a good feature for users with administrative assistants.

Delegates can only be chosen from users with iCal Server in the same authentication 
directory as you. For example, if your user credentials are stored in a directory, like 
Open Directory, the delegate must also be a user in your Open Directory system.

To designate a delegate:
	 1	 In iCal, open Preferences > Accounts.

	 2	 Select the account you want to share with the delegate.

	 3	 Select the Delegation tab.

	 4	 Click the Edit button next to “Manage access to my account.”

	 5	 In the sheet that drops down, click the Add (+) button.

	 6	 Enter the account name who you want to designate as a delegate.

If you want the delegate to change your calendar, check Allow Write.

	 7	 Click Done.

	 40		  Chapter 2    Setting Up and Managing iCal Server



		�  41

Use this chapter to learn about detailed information 
regarding iCal Server that is suitable for advanced system 
administrators.

iCal Server provides calendar sharing, collaboration, and synchronization through the 
CalDAV protocol.

CalDAV is a standard for accessing calendars using WebDAV. It is used to store, query, 
and retrieve collections of iCalendar (.ics) standard events and to-do tasks from a 
CalDAV enabled server to a suitable client. It is an open standard that allows software 
products from many development sources to interoperate.

CalDAV architecture treats all events (individual events in a calendar, to-do lists, and 
out of office blocks) as HTTP resources. The events are transferred using standard 
HTTP with additional functionality to handle the special needs of calendar event 
management.

For example, a CalDAV server must use WebDAV access control (RFC3744), must be 
able to parse iCalendar files (RFC2445), and must be able to conduct calendar-specific 
operations such as doing free-busy time lookup and expanding repeating events.

Each event is an iCalendar (.ics) formatted file. These events are grouped in collections 
(user-perceived calendars) and indexed for searching and quick retrieval.

About iCal Server Configuration Tools
iCal Server uses any of four front-end tools:

Server Admin for Mac OS XÂÂ

The tool ÂÂ serveradmin for Mac OS X

Server Preferences for Mac OS XÂÂ

The tool ÂÂ caldavd for the command-line interface of Darwin server.

3Advanced iCal Server Information



In all these cases, the front ends read from a configuration plist file 
(/etc/caldavd/caldavd.plist) to set service parameters. The plist file is an XML property 
list that specifies server options such as:

The network TCP port to bind toÂÂ

Whether to use SSLÂÂ

The names and locations of support filesÂÂ

For more information on command-line administration, see the serveradmin man 
page and the caldav man page.

About iCal Server Scheduling Operations
In the previous version of iCal Server, when a client made or responded to an 
invitation, the calendar service only brokered the invitation between the parties, 
providing transit for the invitation and response files. This sometimes resulted in 
events not being properly processed, if the originator’s or invitee’s client didn’t process 
the invitation or responses correctly.

However, iCal Server now uses a server-side scheduling mechanism to process  
event invitations and responses without depending on the client. By taking part in  
the transaction between invitations and responses, the calendar server can cache  
the results for faster updating and push notifications without depending on the 
client’s connectivity.

Understanding the Data Store and File Hierarchy for iCal 
Server
By default, the main data store location is /Library/CalendarServer/Documents/, 
but you can specify another location using the Settings tab of the iCal Server 
administration pane in Server Admin.

The CalendarServer folder is owned by root/admin. The Documents folder and all 
folders nested in it are owned by _calendar/_calendar.

The permissions on the hierarchy are set to 740 (user can read, write, and execute; 
group can read and execute; there are no permissions outside of the group), so you 
can’t browse the files without root access.

iCal data files are flat files. They don’t require special tools to inspect them. All file 
properties (including the ACLs) are kept in XML format in the files as extended 
attributes (xattrs). Any backup or file manipulation tool you use to move or edit the 
files must support and preserve extended attributes.
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In Mac OS X Server v10.6, the following command-line tools preserve extended 
attributes:  cp, scp, ditto, tar, pax, rsync (with the -E flag).

In addition to using data files, the calendar server makes extensive use of sqlite 
databases indexes for performance. It uses sqlite to index Globally Unique Identifiers 
(GUIDs) and time spans for events. The sqlite databases are disposable and are rebuilt 
as needed.

Calendar principals (users, groups, resources, and locations) are defined by a GUID.  
A GUID is a 128-bit value hexadecimal notation that uniquely identifies the principal.

This is the organization of the data store:

Location Description

./calendars/__uids__/<WX>/<YZ>/<GUID> Contains files for each user or group that has 
created at least one event, todo, or calendar.

W and X are the first 2 digits of the GUID. Y and 
Z are the 3rd and 4th digits. GUID is the entire 
GUID, including the first 4 digits.

./calendars/__uids__/<WX>/<YZ>/<GUID>/
calendar/

Contains iCalendar (.ics) files of each event in the 
principal’s calendar.

W and X are the first 2 digits of the GUID. Y and 
Z are the 3rd and 4th digits. GUID is the entire 
GUID, including the first 4 digits.

./calendars/__uids__/<WX>/<YZ>/<GUID>/inbox Contains iTIP file invitations to other user’s 
pending events.

W and X are the first 2 digits of the GUID. Y and 
Z are the 3rd and 4th digits. GUID is the entire 
GUID, including the first 4 digits.

./calendars/__uids__/<WX>/<YZ>/<GUID>/
outbox

Nothing is stored in the outbox, but it is used 
as the target for certain types of scheduling 
operations.

W and X are the first 2 digits of the GUID. Y and 
Z are the 3rd and 4th digits. GUID is the entire 
GUID, including the first 4 digits.

./calendars/__uids__/<WX>/<YZ>/<GUID>/
dropbox

Contains files attached to events, either from a 
user's self-created event or from participant events.

W and X are the first 2 digits of the GUID. Y and 
Z are the 3rd and 4th digits. GUID is the entire 
GUID, including the first 4 digits.

Note:  Mac OS X Server v10.5 iCal Server's file structure is different. If you upgrade from 
the old version to Mac OS X Server v10.6, the old file structure is upgraded to the new 
structure on an as-needed basis as users access their calendars. Anyone upgrading 
from Mac OS X Server v10.5 to Mac OS X Server v10.6 may see both directory layouts 
coexisting, although at any one time there is only one path for a GUID.



About Process and Load Management of iCal Server
The daemon for iCal Server has several functional modes. It can be run in master, slave, 
or combined mode.

About iCal server daemon modes
ÂÂ The master process:  Acts as a manager for slave mode daemons and provides 

central logging service. When iCal Server is running in this mode, it forwards calendar 
connection requests to another instance of the daemon running in slave mode.

ÂÂ The slave process:  Accepts forwarded connections delegated by the load balancer. 
This process replies to client requests and accesses the calendar data store, answers 
HTTP requests, and does event parsing.

ÂÂ The combined process (default):  Acts as master and slave. It spawns two slave 
process for every processor core available on the system. It also acts as its own load-
balancer, delegating connections to its own spawned slave mode daemons.
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For these processes to be balanced, they must have a shared storage location. This 
can be as simple as a single file system location for a multiprocessor Xserve. If the 
processes are spread between several servers, the servers must use a shared storage 
solution like Xsan.
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iCal Server Scaling
There are two main methods for scaling iCal Server to meet increasing demand:

Increasing the number of processorsÂÂ

iCal Server is built for multiple processors and multiple processing cores. It creates 
a slave process for every processor core in the system. This process management is 
automatic, and using a server with more cores results in more client activity capacity 
without additional configuration.

Increasing HTTP connection capacityÂÂ

Because iCal Server’s underlying technology is based on the same technologies that 
serve the world wide web, some scaling techniques you would use to handle high 
web client traffic are effective in handling high iCal Server client traffic.

The preferred method of scaling HTTP capacity is using a dedicated load balancer. 
The load balancer distributes client connection load across a group of computers 
running iCal Server.

To the client, there’s only one “front-end” (in other words, one domain name and 
address), and the client’s connection requests are forwarded to one of several back-
end servers.

A less-preferred method of sharing connection load across several iCal Servers is the 
use of round-robin DNS. In round-robin DNS, several IP addresses are associated in 
the DNS to a single domain name. In DNS, the servers are given different priorities, so 
when a higher-priority server is unavailable, traffic is routed to a lower-priority server.

This method has the advantage of not requiring a dedicated load balancer, but 
has the disadvantages of having possibly irregular load distribution and losing the 
performance benefits of a dedicated balancer.

In either case, you must move storage off the iCal Server and on to some shared 
storage system like Xsan. These back-end servers share a common calendar data 
store because any of the computers could take a connection from any client.



The following illustration is an example of a scaled iCal Server system. In the figure,  
the hardware load balancer takes connections from many clients simultaneously.  
It distributes them evenly to the iCal servers.
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Internally to each server, the iCal Server spawns a number of slave processes equal to 
the number of processor cores, and the internal software load balancer distributes the 
connections across its slave processes. As each iCal Server reads from and writes to 
user calendars, it does so from the shared storage pool.
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About iCal Server Implementation Details
iCal Server is implemented using Python v2.6 or later, using the Twisted network 
framework. This open source framework gives excellent network performance using  
an asynchronous networking model without needing to use threads.

The Twisted framework does not support WebDAV level 2 locking or WebDAV 
versioning (neither of which is required for CalDAV).

The following are software dependencies for implementing iCal service:

Third-party tools Apple-provided tools

Twisted PyKerberos

pyXML PyOpenDirectory

pyOpenSSL

vobject

xattr

dateutil

ZOPEInterface

kqueue

libevent

memcached

Getting the Source Code
iCal Server is available as open source software under the Apache 2.0 license. The code 
and comments can be inspected. Administrators who want to contribute features or 
bug fixes can do so at the project site calendarserver.org.



Where to Go for Additional Information

Related Web Sites
Open Source project site:  ÂÂ calendarserver.org

Industry calendaring and scheduling consortium:  ÂÂ calconnect.org

Standards Documents
CalDAV Standards

RFC 4791:  Calendaring Extensions to WebDAV (CalDAV)ÂÂ

DRAFT:  Scheduling Extensions to CalDAVÂÂ

WebDAV Standards
RFC 4918:  HTTP Extensions for Distributed Authoring—WebDAVÂÂ

DRAFT RFC 2518bis:  HTTP Extensions for Distributed Authoring—WebDAVÂÂ

RFC 3253:  Versioning Extensions to WebDAVÂÂ

RFC 3744:  WebDAV Access Control ProtocolÂÂ

RFC 4331:  Quota and Size Properties for Distributed Authoring and Versioning (DAV) ÂÂ
Collections

RFC 5397:  WebDAV Current Principal ExtensionÂÂ

iCalendar Standards
RFC 2445:  Internet Calendaring and Scheduling Core Object Specification ÂÂ
(iCalendar)

RFC 2446:  iCalendar Transport-Independent Interoperability Protocol (iTIP)ÂÂ

RFC 2447:  iCalendar Message-Based Interoperability Protocol (iMIP)ÂÂ

RFC 3283:  Guide to Internet CalendaringÂÂ

Revised Standards (in progress)
DRAFT RFC 2445bis:  Internet Calendaring and Scheduling Core Object Specification ÂÂ
(iCalendar)

DRAFT RFC 2446bis:  iCalendar Transport-Independent Interoperability Protocol (iTIP)ÂÂ

DRAFT RFC 2447bis:  iCalendar Message-Based Interoperability Protocol (iMIP)ÂÂ

HTTP Standards
RFC 2616:  Hypertext Transfer Protocol—HTTP/1.1ÂÂ

RFC 2617:  HTTP Authentication: Basic and Digest Access AuthenticationÂÂ

RFC 4559:  SPNEGO-based Kerberos and NTLM HTTP AuthenticationÂÂ

	 48		  Chapter 3    Advanced iCal Server Information

http://calendarserver.org/
http://calconnect.org/


A
access

delegating  30, 40, 44
permissions  37
SACLs  29
user  29

accounts, setup  39
applications  12
asr tool  36
attachments  24
authentication  11, 31
authorization  29

B
backups, calendar file  36

C
CalConnect Consortium  11
CalDAV (Calendar-Based Distributed Authoring and 

Versioning) protocol  11, 12, 41
calendar service. See iCal service
certificates  32
clients

adding iCal server  39
creating calendars  40
delegating access  30, 40
integration with iCal  12
overview  38
settings  38
See also users

command-line tools
adding users and groups  29
backups  36
data store location  24
logs  34
sqlite  36
See also serveradmin tool

configuration
advanced tools  41, 42
DNS  19
overview  14
sample  13

configuration files  35

cp tool  37

D
Darwin Calendar Server project  11
data store  24, 36, 42
delegating access  30, 40, 44
digest authentication  31
directories. See folders
disks

quotas  24, 25
storage requirements  17

ditto tool  36
DNS (Domain Name System) service  19, 45
documentation  7, 8, 9
Domain Name System. See DNS

E
email event notifications  27
encryption  31, 32
error messages. See troubleshooting
events

attachments  24
CalDAV architecture  41
file organization  36
iCalendar standard  11
notifications  26, 27
scheduling mechanism  42

F
file systems

data store  24, 36, 42
processes  44
scalability  12

files
calendar  36
configuration  35
hierarchy  42
property list (plist)  42

folders, data store hierarchy  42

G
groups  29
gzip tool  37

�Index

		�  49

In
de

x



	 50		  Index

H
help, using  6
host name  25
HTTP (Hypertext Transfer Protocol)  11, 26, 41, 45

I
iCal Server

access control  29, 30
CalDAV architecture  41
client support  38, 39, 40
deleting calendars  37
DNS  19
enabling  18
host name  25
load management  44
logs  34, 35
management of  35, 36
monitoring  34
notifications  26, 27
overview  5, 10, 11, 12
ports  26
requirements  14
resources and locations  30
scalability  12
scaling methods  45
scheduling  42
security  31
settings  22
setup  13, 14, 41
software dependencie  47
source code  47
starting  19
stopping  19
storage considerations  24, 25
wikis  33

iCalendar standard  11
installation, planning for  14, 17
invitations  26, 27
iTIP standard  11

K
Kerberos  11, 31

L
launchctl tool  37
load balancing  44
logs  34, 35

M
Mac OS X Server, integration with iCal  11
mail notifications  27

N
networks, load resources  17

O
Open Directory  11
Open Directory master  30
open source modules  11, 47

P
pax tool  37
permissions  37
ports  26
problems. See troubleshooting
property list (plist) files  42
protocols

CalDAV  11, 12, 41
HTTP  11, 26, 41, 45
load resources  17

push notification  26
Python  47

Q
quotas, disk  24, 25

R
requirements  14
root permissions  37
round-robin DNS  45
rsync tool  36

S
SACLs (service access control lists)  29
SANs (storage area networks)  12
scp tool  37
Secure Sockets Layer. See SSL
security

authentication  11, 31
SSL  19, 32
See also access

Server Admin  22, 35
serveradmin tool

attachment size limit  24
authentication  32
enabling server  18
host name  25
logs  35
mail notifications  28
port setting  26
push notification  27
SSL  32
starting service  19
stopping service  19
user quotas  25
wikis  33

servers, host name setting  25
service access control lists. See SACLs
service record. See SRV
setup procedures. See configuration, installation



	 Index	 51

software dependencies  47
sqlite databases  36
SRV (service) record  19
SSL (Secure Sockets Layer)  19, 32
storage area networks. See SANs
storage considerations  17, 24, 25, 36, 42

T
tail tool  34
tar tool  37
Time Machine  37
troubleshooting  36
Twisted network framework  47

U
user accounts  16
users

access control  29, 30
attachment quotas  24
disk quotas  25
See also clients

V
volumes. See file systems

W
WebDAV (Web-Based Distributed Authoring and 

Versioning)  11, 41, 47
wikis  11, 33

X
Xsan  12


	iCal Server
	Contents
	Preface:�  About This Guide
	What’s New in iCal Server
	What’s in This Guide
	Using Onscreen Help
	Documentation Map
	Viewing PDF Guides Onscreen
	Printing PDF Guides
	Getting Documentation Updates
	Getting Additional Information

	Chapter 1:  Understanding iCal Server
	iCal Server Features
	Open Standards
	Directory and Client Integration
	Service Scalability
	Client Applications That Integrate with iCal Server
	Third-Party Applications

	iCal Server In Action

	Chapter 2:  Setting Up and Managing iCal Server
	iCal Server Minimum Requirements
	Setting Up iCal Server
	Planning for iCal Server Computing Resources
	Enabling iCal Server Administration in Server Admin
	Starting or Stopping iCal Server
	Configuring DNS for iCal Server
	Understanding iCal Server Administration Settings
	Changing the Calendar Data Store Location
	Changing the Maximum Attachment Size
	Changing Calendar User Quotas
	Setting the iCal Server Host Name
	Setting the iCal Server Port Number
	Setting the iCal Push Notification Server
	Enabling Mail Notifications to Attendees

	Creating the iCal Server’s Service Access Control List
	Creating iCal Resources and Locations
	Delegating Access to a User’s Calendar
	Configuring Security for iCal Server
	Choosing and Enabling Secure Authentication for iCal Server
	Configuring and Enabling Secure Network Traffic for iCal Server

	Make iCal Server Host a Wiki Server’s Calendar
	Monitoring iCal Server
	Viewing iCal Server Logs
	Setting Logging Levels
	Rotating iCal Server Access Logs

	Maintaining iCal Server
	Understanding iCal Server Administration Configuration Files
	Understanding Calendar Files
	Backing Up and Restoring Calendar Files
	Deleting Unused Calendars

	Supporting iCal 4.0 Client Users
	Account Settings for iCal Client
	Adding an iCal Server Account to an iCal Client
	Creating a Calendar on an iCal Server Using iCal Client
	Setting a Delegate Using iCal Client


	Chapter 3:  Advanced iCal Server Information
	About iCal Server Configuration Tools
	About iCal Server Scheduling Operations
	Understanding the Data Store and File Hierarchy for iCal Server
	About Process and Load Management of iCal Server
	iCal Server Scaling
	About iCal Server Implementation Details
	Getting the Source Code
	Where to Go for Additional Information
	Related Web Sites
	Standards Documents


	Index


